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Information in this document is subject to change without notice and does not represent
a commitment on the part of the manufacturer.  No part of this manual may be
reproduced or transmitted in any form or by any means, electronic or mechanical,
including photocopying and recording, for any purpose without the express written
permission of the manufacturer.

© 2008 Instrumentation Northwest, Inc.
Registered trademarks and trademarks belong to their respective owners.

Contains FCC ID: OUR-9XCITE
The enclosed device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions: (i) this device
may not cause harmful interference and (ii) this device must accept
any interference received, including interference that may cause
undesired operation.

Contains FCC ID: OUR-9XTEND
The enclosed device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions: (i) this device
may not cause harmful interference and (ii) this device must accept
any interference received, including interference that may cause
undesired operation.

The RF radio modules in these WaveData radio units have been
certified for remote and base radio applications. They have not been
certified for “portable” use. Portable use is considered by the FCC to
be when the antenna is mounted closer than 20 cm to nearby
persons. INW makes no claim that the RF energy levels emitted by
these devices are within permissible limits, as defined by the FCC,
when used closer than 20 cm to the body.WARNING
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Introduction

What is a WaveData RF Data Collection System?

WaveData® RF Data Collection Systems combine INW’s patented AquiStar® Smart
Sensor/Dataloggers with radio frequency modems to create powerful data collection
and monitoring systems.

Operating on the 900 MHz band, these radio frequency modems are license free.
Depending on the model and usage, these low power units can run for months on
alkaline batteries or virtually forever on solar systems. Communication range varies from
300 feet to 5 miles, depending on line-of-sight obstructions, height and type of anten-
nas, power settings on radio, and additional repeaters.

The AquiStar® Smart Sensors store thousands of records, operate on low power, and
feature easy to use software with powerful features, including the ability to create
complex test sequences and display uploaded data in tables and graphs.

Initial Inspection and Handling

Upon receipt of your WaveData unit, inspect the shipping package for damage. If any
damage is apparent, note the signs of damage on the appropriate shipping form. After
opening the carton, look for concealed damage. If concealed damage is found, immedi-
ately file a claim with the carrier.

About this Manual

This manual concentrates on installation and configuration of WaveData systems. It
also includes information on technical details and trouble-shooting . For instructions on
using the WaveData units with INW’s Aqua4Plus control software, please refer to the
Aqua4Plus Control Software Instruction Manual.

WaveData wireless data collection systems are highly configurable and expandable.
Due to the plethora of possible configurations, this manual will concentrate on a basic
configuration as shown in figure 1.

Bear in mind that each system may contain several remote units. Each remote may be
connected to several smart sensors.

Each system, other than a very basic system, comes with documentation for setup,
configuration, and installation of that specific system. Please refer to that custom
documentation as needed.
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Figure 1: Basic WaveData Configuration

Radio Types

Host Radios

There are two radio types in any given radio network – a host radio and one or more
remote radios. The host radio is connected directly to the controlling computer (or to a
modem, in the event you are communicating via a modem.) This host radio contains a
map of the entire network layout, including all radios and all sensors.

The host radio performs two functions. First it makes sure that all radios the computer is
attempting to communicate with or through are awake. Second, the host passes commu-
nication back and forth between the computer and the sensors and/or remotes, making
sure the information goes down the correct network leg to the destination specified by
the program on the computer.

Host radios can communicate with the controlling computer program only when directly
connected to a computer (or via modem, as noted above).  Host radios are always at
sensor address 1.

Both host and remote units have built in power saving features. The host radio goes to
sleep immediately after any communication and remains asleep until there is activity on
its communication line from the computer.

Remote Radios

Remote radios are either directly connected to sensors or act as repeaters. When
connected to one or more sensors, a remote radio will pass communication back and
forth between the host and the sensors. A remote radio can also be used as a repeater to
get further distance or to avoid obstacles such as hills or buildings. When acting as a
repeater, a remote radio simply passes on whatever information it receives.

Remote radios can communicate only over the air. They cannot be directly connected to
a computer for communication.

Computer WaveData
Host

WaveData
Remote

Smart
Sensor
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Remote radios go to sleep 60 seconds after the last transmission or receipt of informa-
tion. While in sleep mode, a remote radio wakes up very briefly every 10 seconds to see
if anyone is transmitting to it.

Aqua4Plus Software

The WaveData system comes with INW’s Aqua4Plus host software.  This software is
used to control the WaveData radio units, as well as program and retrieve data from the
smart sensors. Install Aqua4Plus on your PC or laptop as follows:

1. Insert the Aqua4Plus CD in the CDROM drive on your PC or laptop. Installation
should start automatically. If not, then follow steps 2 and 3. Otherwise, skip to
step 4.

2. Click the Start button and select Run.
3. Type D:\setup.exe, where D: is the drive letter for your CDROM drive.
4. The Installation program will guide you through the installation process.

Once the software installation has successfully completed, remove the CD from your
CDROM drive and store it in a safe place.

To start the Aqua4Plus software, use the Start Menu to navigate to the program group
you selected during installation (typically this will be Aqua4Plus), and then click the

Aqua4Plus  icon. Refer to the Aqua4Plus Control Software Instruction Manual for
details in using the program with your WaveData unit.

Installation Considerations
Installations may vary widely. Refer to specific installation instructions for your particu-
lar project.  All of the following installation samples are for units running on internal
battery power. For more information on alternate power sources - line power, solar,
generator - contact your INW representative.

Location

Care must be taken when locating the WaveData units. These RF radios communicate
with each other via line-of-sight. In other words, they must be able to “see” each other
for effective communication. (If you do not have line-of-sight, contact INW about using
repeaters to reach your destination.)

Line-of-sight in the radio world is slightly different than line-of-sight in the visual world.
Figure 2 shows a visual line of sight. If you were at the top of one of the antennas, you
would have a straight line of vision to the second antenna.
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On the other hand, radio antennas radiate in a bubble, known as the Fresnel zone. (See
figure 3.)  Any objects – trees, buildings, the ground – that intrude into this bubble
degrade communication.

The Fresnel zone diameter increases with distance. Table 1, below, gives some approxi-
mate diameters and typical ranges. Remember that objects intruding into the Fresnel
zone will shorten these distances.

Table 1

In addition to location and height of your antenna , the distance and reliability with
which your WaveData unit communicates is directly affected by the type and gain of
antenna you are using. For further details, see INW’s application note “Antenna
Selection and Location for WaveData Wireless Data Collection Systems.”

Grounding Issues

Grounding does two things. First, it protects equipment and personnel from high power
spikes. Second, it improves measurement accuracy by eliminating ground loops.

        Figure 2: Visual Line-of-Sight                            Figure 3: RF Line-of-Sight
                                                                                        Fresnel zone interrupted by trees

1 Source: RF Essentials. MaxStream Wireless Technology Training. MaxStream. Lindon,
UT: 2003.
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Safety Concerns

It is commonly known that when using electronic equipment, both personnel and
equipment need to be protected from high power spikes that may be caused by light-
ning, power line surges, or faulty equipment. Without a proper grounding system, a
power spike will find the path of least resistance to earth ground, whether that path is
through sensitive electronic equipment or the person operating that equipment. In order
to ensure safety and prevent equipment damage, a grounding system must be used to
provide a low resistance path to ground.

Ground Loop Effects

When using several pieces of interconnected equipment,
each of which may have its own ground, problems with
noise, signal interference, and erroneous readings may be
noted. This is caused by a condition known as a Ground
Loop. Because of natural resistance in the earth between the
grounding points, current can flow between the points,
creating an unexpected voltage difference and resulting
erroneous readings.

Maximizing Safety and Minimizing Ground Loop Effects

Proper grounding and the use of surge protectors are very
important to ensure that your system provides a single low
resistance path to ground. This will shunt high voltage
spikes to ground, helping to prevent equipment damage and
personal injury.

           Figure 4:
Improper grounding can
be a safety hazard!

The single most important step in minimizing a ground loop is to tie all equipment
(sensors, dataloggers, external power sources, housings, radios, cell modems, and any
other associated equipment) to a single common grounding point.

Refer to the U.S. Consumer Product Safety Commission, the National Electrical Code,
and/or an electrical engineer with experience in grounding issues before installing your
system.
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Using a WaveData RF Data Collection System

Connecting Radios

Connecting Remotes to Sensors

Connect your sensor to the connector next to the antenna. If you are going to connect
several sensors via a junction box, connect the junction box at this point.

Figure 5: WaveData box connected to sensor

Connecting Host to Computer or Modem

Connect the host radio to your computer, as shown below.

Figure 6: WaveData box connected to computer

Connect the host radio to a modem, as shown below:

Figure 7: WaveData box connected to modem

Serial Cable

RS485 Cable

RS232/RS485
Adapter

Null Modem
Cable

RS485 CableRS232/RS485
Adapter



9
Configuring Radios

Turning on Power

                                            

Figure 8: Power switch

Turn on power to each of the radios by pressing firmly on the power switch. When
power is on, a blinking green LED will be visible in the top right corner. (You may have
to look closely, as it is below the metal faceplate.)

Configuring Host Radio

The host radio must have a map of your network. You can view and/or change this map
or create a new one as follows:

• Start Aqua4Plus
• Select the COM port to which the host radio is connected.
• Set Communication Options (Options Menu > Communication)

° From the Factory Suggested Settings, select WaveData Radios (or IP Cell
Modem and Radios, if using a cellular modem).

° Set both the Lowest Sensor Address and Highest Sensor Address to 1.
° Be sure that the Enable S/F Radio Wakeup box is checked.

° Click OK

Figure 9: Communication options

Power light

Power switch
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• Scan for the WaveData units by clicking the    tool button. The program

should find the WaveData Host and display as shown below. (Note that host
radios are always on address 1.)

Figure 10: Sensor window showing host radio unit

• Be sure the Host is highlighted in the sensor window, then open the Radio
Sensor Map: Utilities Menu > Advanced Utilities > Radio Sensor Mapper

• From the Radio Sensor Map, click the File menu. You will have the following
choices:

Create a new map
Open an existing map from disk
Save a map to disk
Save a map to disk with a new name
Upload the map currently on the host radio

Write the open map to the host radio

Figure 11: File menu on Radio Sensor Mapper

• Create a network map for your network.
Every WaveData RF network must have a map loaded into the host radio that
describes the layout of the network. (If INW engineers the system, we will
provide the needed network map.)

Every radio and every sensor must be included in the map and must detail how
they are connected and what addresses they use. Figure 12 illustrates a map for a



11
simple network. This network has one host radio (address 1) which communicates
with one remote radio (address 2) to which is connected one sensor (address 4).
Note that host radios are always on address 1.

                                        Figure 12: Simple network map

Note: For best results, when configuring your network use as low numbered
addresses as possible, with as few skipped addresses. (See Appendix A for
further network samples.)

• Write the map to the host.
Once the map has been created, you must write it to the Host (File Menu > Write
to Host). You may also save it to disk for future use by selecting Save or Save As.
(See Appendix A for details on creating and modifying network maps.)

Setting Communication Options

Before using your network, you must set the proper communication options in
Aqua4Plus.

• Start Aqua4Plus
• Select the COM port to which the host radio is connected.
• From the Options menu, select Communications to open the Communications

Dialog box.
• From the Factory Suggested Options dropdown list, select WaveData Radios (or

IP Cell Modem and Radios, if using a cellular modem).
• Set the Lowest Sensor Address to 1. The host is always at address 1.
• Set the Highest Sensor Address to the highest address used on your network.

(Note: For best results, when configuring your network use as low numbered
addresses as possible, with as few skipped addresses.)

Your Communications Options box should looks similar to the one shown in figure 13:
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Figure 13: Communication options

Configuring Remote Radios

• Scan for the WaveData units and sensors by clicking the   tool button. The
program should find all the radios and sensors that were defined in your network
map.

° Since the radios go to sleep when not in use, the host radio will need to wake
up each radio. The host handles this automatically whenever you attempt to
communicate to a radio or sensor. A   message will display
on the tool bar, whenever the host is attempting to wake up the radios. Be
patient, this may be slow, depending on your network configuration. Once all
the radios and sensors have been found, they will be displayed on the sensor
panel.

Figure 14: Radios and sensors displayed on sensor panel
• To change the description on a selected radio or sensor, click the Configure

Menu, and then select Sensor Description. Enter the description and click OK.
• To change the address on a selected radio or sensor, click the Configure Menu,

and then select Sensor Address. Select a new address and click OK.
Warning! If you change a sensor address, it will no longer be visible to
Aqua4Plus. If you change a radio address, that radio and all radios and/or
sensors downstream from that radio will no longer be visible to Aqua4Plus. You
must update the map in the host to reflect the address changes.
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Controlling Sensors

Once your network is set up, you can access and control your sensors in the same way
you would if they were directly connected to your computer. The only difference is that
communication will be slower. Be patient.  (See the Aqua4Plus Control Software
Instruction Manual and the manual for your particular sensors for information on
accessing and controlling the sensors.)

Technical Information

Wiring Diagrams

Pin-out on WaveData Boards

                           High power unit                                       Low power unit
Figure 15: Pin-out on WaveData boards

RS485 Cables

An RS485 extension cable is terminated with round weatherproof connectors on both
ends and runs from a remote unit to a Smart Sensor or junction box.

Figure 16: RS485 cable extension  cable

1
2
3
4
5

1
2
3
4
5

Vaux Sensor Power*
D-
D+
Digital out from Sensor
Ground

*Power to smart sensors. Limited to 15V, 100mA.
Available only when Vaux is supplied to WaveData unit.

Round
Weather-

proof
Connector

To WaveData To Sensor

Round
Weather-
proof
Connector
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2
3

4

1
2
3
4
5

D-
D+

Ground

Round
Weather-
proof
Connector

To WaveData

9-pin
D-Sub

Connector

To RS232/485
Adapter

An RS485 communication cable is terminated with a round weatherproof connector on
one end and a 9-pin d-sub connector on the other. This cable runs from the RS232/
RS485 adaptor (which connects to the PC or a modem) to a host unit.

Figure 17: RS485 communication cable

Battery Life

Basic WaveData radio packages come with a 12 VDC power supply, consisting of eight
AA alkaline cells. D cell packs are also available. Battery life will vary depending on
radio type, amount of usage, and whether sensors are powered from the same power
pack. Table 2 shows some sample battery life scenarios.

Table 2

Note: Upload times, and thus power consumption, may vary depending on signal
strength. Uploads times will be longer on networks with repeaters. Contact INW for
other battery and solar power options.
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Specifications

OUTPUTS

1-Auxiliary Power Out 50 mA, 12 VDC, for use by AquiStar® Smart Sensors
2-Switched Power Out 9-24 VDC (6 amps)(High power model only)

RADIO TRANSCEIVER

Frequency Ranges 902 - 928 MHz (Low power model)
905 - 925 MHz (High power model)

Type Frequency Hopping/Spread Spectrum
Transmit Power Output 0.01 to 1.0 Watt (depending on model)
Rx Sensitivity -108 / -104 dBm (Low power model)

-110 / -100 dBm (High power model)
Range - Indoor 300’ to 1500’
Range - Outdoor Up to 5 miles (depending on model)
FCC Part 15.247 certification

POWER SUPPLY REQUIREMENTS

Battery 12 VDC
Auxiliary

Low Power Model
Voltage 9 - 15 VDC
Current 100 mA @ 12 VDC

High  Power Model
Voltage 9 - 15 VDC
Current 500 mA @ 12 VDC
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Advanced Configurations

Configuring a Radio as a Host or Remote

Host radios can be made into remote radios and vice versa. This is done using the Radio
option under the Advanced Configure menu. Contact INW for details, if you need to do
this.

WARNING! Do not attempt to make changes without guidance from INW.

Using Relays

Some models of WaveData radios have two switched relays on the radio board that can
be used to remotely control equipment connected to those relays. These can be used to
turn on/off pumps, control power booster packs, and other activities. Contact INW for
details, if you are interested in using these relays.

Appendix A: Network Maps

Creating and Modifying Network Maps

Network maps are created and modified using the Radio Sensor Mapper, which can be
accessed from Utilities Menu > Advanced Utilities > Radio Sensor Mapper.

To view the network map currently loaded in the host radio, click the File menu, and then
select Upload from Host. The current map will be displayed.

To create a new network map, click the File menu, and then select New. A map will
display showing only a host radio.

Figure 18: Radio Sensor Map showing only a host radio
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To add a radio to a map:

• Click on the radio (host or other radio) to which the new radio will be communi-
cating.

• Click on the Radio menu, and then select Add Radio. Select the address for that
radio, and then click Add.

Figure 19: Adding a radio

• The new radio should appear on the map, as shown below:

Figure 20: Host and one radio

To add a sensor to a map:
• Click on the radio (not host) to which the new sensor will be connected.
• Click on the Radio menu, and then select Add Sensor. Select the address for that

sensor, and then click Add.
• The new sensor should appear on the map, as shown below:

Figure 21: Host, Radio, and one sensor
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To delete a radio or sensor from a map:

• Click on the radio or sensor you want to delete.
• Click on the Radio menu, and then select Delete Radio or Delete Sensor. (Note:

deleting a radio that has radios or sensors downstream from it will also delete
those radios and/or sensors.)

Sample Network Maps and Corresponding Networks

Figure 22-a: Sample network 1

Figure 22-b: Sample network 2

Figure 22-c: Sample network 3

Radio 2
Repeater

Radio 3

Sensors
4 and 5

Sensor 4

Radio 3

Sensor 5

Radio 2

Radio 2

Sensors
3 and 4
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Appendix B: Trouble-Shooting

Can’t Find Host Radio

1. Be sure cabling between computer and host WaveData unit is securely attached.

2. Be sure power is on to the WaveData unit. A green LED visible through the upper
right corner of the WaveData box will blink when power is on.
If running on batteries:
• The power switch is on the bottom of the WaveData box. Press in firmly to

activate.
• If unit has been working but has recently stopped, replace batteries with fresh

batteries.
If running on auxiliary power:
• Consult specific information for your unit to be sure power is being supplied.

3. Be sure that the correct COM port is selected in Aqua4Plus. (See figure 23.) If
you do not see your COM port listed, first be sure it is not in use by another
application. Then be sure that Highest COM Port is set appropriately, as
Aqua4Plus will not list any COM ports higher than this setting. See the Commu-
nication dialog box under the Options  Menu. (See A on figure 24).

Figure 24: Communication Dialog Box

Figure 23: Selecting COM Port

Range of addresses
that will be scanned

Retry and
TimeOut
Levels

List of suggested
settings

Enable S/F
Radio Wakeup

Highest COM port
listed on Main Menu
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Can’t Find Remote Radio

1. Be sure Aqua4Plus can find the Host Radio. If not, see previous section.

2. Be sure your communications options are set appropriately - Select the Communi-
cation Option on the Options Menu.
• Be sure you have selected WaveData Radios or IP Cell Modem and Radios, if

using a cellular modem. (See B on figure 24.)
• Be sure that you are scanning the proper range of addresses to find each unit.

Each WaveData unit and each Smart Sensor has a unique address, known as
the Modbus address or Sensor address. To increase scanning speed,
Aqua4Plus is often set to scan a limited number of addresses. Adjust Lowest
and Highest Sensor Address as necessary. (See C on figure 24.)

• Be sure Enable S/F Radio Wakeup has been checked. (See D on figure 24.)

3. Be sure the network map in the host matches your actual network layout.

4. Occasionally, Retry and TimeOut levels may need to be increased. (Options
Menu, Communications options - see E on figure 24.) Retry Level is how many
times Aqua4Plus tries to communicate with a remote radio or a sensor before
giving up. TimeOut level is how long (in milliseconds) Aqua4Plus waits for a
response from a remote radio or a sensor before retrying. If you continue to have
difficulty finding remote units, increase the timeout level slightly by clicking on
the indicator and dragging to the right. Note that the more retries and the higher
the time outs, the longer the scan time.

5. Be sure antenna connections at both host and remote radio are secure, if using an
external antenna.

6. Be sure you have a clear RF line-of-sight between the host and remote radio. (See
Installation Considerations earlier in this manual.)

7. Be sure power is on to the WaveData unit. A green LED visible through the upper
right corner of the WaveData box will blink when power is on.
If running on batteries:
• The power switch is on the left side of the bottom of the WaveData box. Press

in firmly to activate.
• If unit has been working but has recently stopped, replace batteries with fresh

batteries.
If running on auxiliary power:
• Consult specific information for your unit to be sure power is being supplied.
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Can’t Find Smart Sensors

1. Be sure Aqua4Plus can see the WaveData unit to which the sensors are attached.
If not, see previous section.

2. Be sure connections from WaveData unit to sensors are secure.

3. Be sure that you are scanning the proper range of addresses to find each unit.
Select the Communication Option on the Options Menu. Adjust Lowest and
Highest Sensor Address as necessary. (See C on figure 24.)

4. Be sure the network map in the host matches your actual network layout.

5. Increase the Timeout Level slightly. (See details under section 4 of Can’t Find
Remote Radio.)

Can Find Smart Sensors But Can’t Reliably Communicate

1. Increase the Retry Level and/or the Timeout Level slightly.

2. Be sure connections from WaveData unit to sensors are secure.
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Appendix C: Using USB to Serial Cables
The standard communication cable/RS485-232 adapter plugs into a 9-pin serial port on
the PC or laptop. Many new computers, especially laptops, do not come with 9-pin serial
ports. If you have one of these computers, or if all of your serial ports are in use, you
can connect to a host unit using a USB to Serial adapter, as shown below.

Figure 25: Connection using a USB to Serial Cable

USB-to-Serial cables are readily available from many electronics and computer stores, as
well as numerous sites on the Internet.  INW has tested and recommends the Keyspan
USA-19HS. It is available from INW or various places on the Internet.

Install as follows:
• Plug into USB port
• Install the drivers provided with the particular unit
• Determine the port number to which the adapter assigned

o Right-click on My Computer
o From the popup menu, select Manage to open the Computer Manage-

ment window
o On left panel, click on Device Manager
o On right panel, double-click on Ports
o A list of active COM ports will be displayed. Note the COM number

assigned to the adapter you just installed.

For example:  
o Close Manager.

• Connect to the host unit.
• On the Aqua4Plus software, select the COM port. (Note: if you do not see your

new COM port in the drop-down box, open the Communications dialog box
from the Options menu. Increase the Highest COM port number.)

Communication
Cable

Host
Radio

PC or Laptop
Computer

USB Port
USB to Serial

Cable

RS232/RS484
Adapter
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Reordering Information

For sales & service offices, please contact:

Instrumentation Northwest, Inc.
www.inwusa.com

800-776-9355
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LIMITED WARRANTY/DISCLAIMER - WaveData®

WIRELESS DATA COLLECTION SYSTEM

A.   Seller warrants that products manufactured by Seller when properly installed shall
be free from defects in material and workmanship.   Seller’s obligation under this
warranty shall be limited to replacing or repairing the part or parts or, at Seller’s option,
the products which prove defective in material or workmanship within ONE (1) year
from the date of delivery, provided that Buyer gives Seller prompt notice of any defect
or failure and satisfactory proof thereof.   Any defective part or parts must be returned
to Seller’s factory or to an authorized service center for inspection.   Buyer will prepay
all freight charges to return any products to Seller’s factory, or any other repair facility
designated by Seller.   Seller will deliver replacements for defective products to Buyer
(ground freight prepaid) to the destination provided in the original order.   Products
returned to Seller for which Seller provides replacement under this warranty shall
become the property of Seller.

This limited warranty does not apply to lack of performance caused by abrasive materials,
corrosion due to aggressive fluids, mishandling or misapplication.   Seller’s obligations under
this warranty shall not apply to any product which (a) is normally consumed in operation, or (b)
has a normal life inherently shorter than the warranty period stated herein.

In the event that equipment is altered or repaired by the Buyer without prior written approval by
the Seller, all warranties are void.   Equipment and accessories not manufactured by the Seller
are warranted only to the extent of and by the original manufacturer’s warranty.

THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES,
WHETHER ORAL, WRITTEN, EXPRESSED, IMPLIED OR STATUTORY.   IMPLIED
WARRANTIES OF FITNESS AND MERCHANTABILITY SHALL NOT APPLY.   SELLER’S
WARRANTY OBLIGATIONS AND BUYER’S REMEDIES THEREUNDER (EXCEPT AS TO
TITLE) ARE SOLELY AND EXCLUSIVELY AS STATED HEREIN.   IN NO CASE WILL
SELLER BE LIABLE FOR CONSEQUENTIAL DAMAGES, LABOR PERFORMED IN
CONNECTION WITH REMOVAL AND REPLACEMENT OF THE WAVEDATA SYSTEM,
LOSS OF PRODUCTION OR ANY OTHER LOSS INCURRED BECAUSE OF INTERRUP-
TION OF SERVICE.   A NEW WARRANTY PERIOD SHALL NOT BE ESTABLISHED FOR
REPAIRED OR REPLACED MATERIAL, PRODUCTS OR SUPPLIES.   SUCH ITEMS
SHALL REMAIN UNDER WARRANTY ONLY FOR THE REMAINDER OF THE WAR-
RANTY PERIOD ON THE ORIGINAL MATERIALS, PRODUCTS OR SUPPLIES.

B.   With respect to products purchased by consumers in the United States for personal use, the
implied warranties including but not limited to the warranties of merchantability and fitness for a
particular purpose, are limited to twelve (12) months from the date of delivery.

Some states do not allow limitations on the duration of an implied warranty, so the above
limitation may not apply to you.   Similarly, some states do not allow the exclusion or limitation
of consequential damages, so the above limitation or exclusion may not apply to you.   This
limited warranty gives you specific legal rights; however, you may also have other rights which
may vary from state to state.
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